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Wilbur
Your File Assistant

en FRANÇAIS
po POLSKU

Wilbur is now FREE!
Wilbur version 2.1 is being released as a free software program under the provisions of the GNU

General Public License of the Free Software Foundation.
(The same licensing as Linux)

(Now available in English, French and Polish Versions)

Download Version 2.1 Build 20
( pdf file capability)

Put your WilburNotes where you want them:
WilburNoteRegistrySetter

(A utility contributed by Leo Singh>

Every office seems to have one vital person who is the only one who can find anything in the file cabinets.
Wilbur wants to be the electronic equivalent of that person for your computer.
His Qualifications:

� He's fast

� He's efficient

� He's FREE!.

� His source code is available
Give him a chance and he will quickly make an index so he can tell you where to find files containing any
information you need now.
Check out his features and download a copy.
If you are already a Wilbur user, check out what's new in version 2.1update.htm.
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Wilbur's Help Contents
for Version 2.1

General
� Wilbur’s Mission
� Wilbur’s Display
� Getting Started
� Miscellaneous Tips Etc.

Commands
� File menu
� Edit menu
� Index menu
� Search menu
� View menu
� Help menu

Miscellaneous
� Command Line Parameters
� OLE Automation Routines
� WilburUtil
� WilburNote
� CDWilbur
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General - Wilbur's Mission
Wilbur’s mission is simply to help you find things on your hard disk. The ever increasing size of
hard disks makes it possible to store all kinds of good stuff on your computer and keep it there
forever. Unfortunately finding something in this mess can be rather difficult.
Wilbur can prepare an index which not only contains the names and attributes of all the files and
folders on your disks, but also the words that appear in files that contain text. Using this index
Wilbur can quickly show you things like:

� all the files with the phrase "gas bill" in them
� any file with mary in its name
� all the files in folders with admin in the folder name
� all the files contained in zip archives
� all the sound files on your disk
� all the files that have been modified this week

and lots more. These types of requests can be combined so that you could ask for all the files on
disk D containing "gas bill" or "over due" that have mary in the name and have been modified this
week.
Wilbur can display the text contained in files and if a search was done for certain words, those
words will be highlighted in context. You can either view just the lines containing matches or all the
text in the file. Wilbur can also copy (including in and out of ZIP archives), launch, edit and
perform other operations on the files found.
Please note that Wilbur is a Win32 program and will only run on the Intel version of WinNT and
Win95. It will not run with the Win32s extensions for the 16 bit Windows.
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General - Wilbur's Display
Wilbur uses a simple two pane window with a menu and tool bar to display his results. (You may
click anywhere on the image below for help on a particular feature).

The top pane is a list of files that meet the current search criteria.
The lower file contents pane displays the text contents of any file selected in the file list and
highlights the first occurrence of a search word. If the background of the contents pane is light
yellow, as shown above, then the results are being presented in outline mode, with only lines
containing target words being shown. This can be toggle to full text with the outline command.
Wilbur does not attempt to do anything beyond basic formatting of this text, but double clicking on
the file name in the list will launch the file in its’ associated application and right clicking in the
contents pane will launch QuickView.
You can change the amount of area assigned to each pane by using your mouse to point at the
divider between the two panes, and then pressing and holding the left mouse button while dragging
the divider to the desired position.
At the bottom of the screen is a Status Bar where Wilbur reports various tidbits about what it is
doing. The Tool bar and Status Bar can be toggled on and off by means of the View menu.
For more details on how you can view files, please see the help on the file list pane and file contents
pane.
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General - Getting Started
The first time you run Wilbur, your web browser will be fired up and you should end up looking at
this page. This will only happen the very first time you run Wilbur, but you can always return here
by selecting "Getting Started" from the help menu.
Getting Started Contents

� Using Help
� Reading the Doc - Yeah right!
� Building Your First Index
� Doing a Search

I would also recommend having a look at the Wilbur Display help and at the Preferences help. You
don't really need to know anything about the preferences to get going, but it is a good idea to just
have a look and see what it there.
If things still seem confusing or you have any questions or comments, please do not hesitate to
EMail us, post a message to WilburTalk or leave a message on our secure message page. You can
even <shudder> fax us at +1.250.423.6519.

Getting and Using Help
Wilbur uses your default Web browser to present its information in a familiar and rich environment.
The web pages that comprise the actual help system are all installed on your local machine, so there
is no need to be connected to the Internet to use help. Some links, like those to our home page will
require an internet connection, but none of those are necessary for normal use.
The easiest way to get help is to just press the F1 key. If a dialog is open or a menu item is selected,
Wilbur will offer help on that item, otherwise Wilbur will present the general help contents.

You can also get help about menu and tool bar items by selecting the context help toolbar button
and then clicking on a toolbar button or selecting a menu command.
Of course Wilbur itself is a great tool for providing a full word index of the help system. You create
this help index while working through the Getting Started section.
Finally if you still need help, please email us and we would be happy to try and help.

Reading the Doc
- Yeah Right! -

People who write programs always hope you will read all of their documentation carefully, but in
reality we just dive into other programs and can hardly expect our users to do otherwise.
Still at least checking out the basics is likely to make Wilbur more useful to you, so we have
prepared this getting started section to briefly explain the fundementals while working through a
brief example. The example is even useful as it will create an index of Wilbur's help files so you
can find stuff in all the pages you didn't bother to read. :-)

Building Your First Index
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In order to do its thing, Wilbur reads your disk and creates an index of information about the files
you have. When you do a search Wilbur consults this index rather than searching through all those
files again. This permits very fast searches, but means the first step in using Wilbur is to create an
index.
When you run Wilbur for the first time and whenever you create a new index, Wilbur will pop up a
dialog that looks something like this:

If you don't see index properties dialog, select new from the Wilbur file menu or click on the
toolbar button.
In an attempt to make things easy, Wilbur fills in the include list with the file extensions for a
variety of common files that might contain text. The "*:" at the beginning of each line tells Wilbur
to look on all non removable disks for files of that type, but that is a detail best left to the Include
Files help page.
For now we don't want to index all that stuff, so just hit the Clear button to get rid of everything,
and then click on the Add button to bring up this dialog:

Click on the browse button and you will get a standard Windows file open dialog. It shows the
contents of the Wilbur folder and the first entry will probably be a Help folder. Double click on this
and you should see something like this, although the file names will probably be different:
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Since all of the text containing Wilbur help files have HTM as an extension, type *.htm into the File
name field and click on the Open button. The Include Path dialog should reappear with the path
name of these files in the input field. Hit OK to add this path to the empty include list.
That is all that is really necessary, but before leaving we might as well look at the other pages in the
Index Properties dialog. To switch pages, just click on the Exclude Files, Options or Language tab
at the top of the dialog. The Exclude Files page is identical to the Include Files page and is used to
omit files from content indexing that would otherwise be caught up in the net of included paths. For
instance we could have include "*.*" in the help directory and then excluded "*.gif" to avoid
indexing the images. It is usually better to be more precise with the include paths than relying on
excluding files.
The options page:

provides a number of useful ways of controling how your files are indexed. These are discussed on
the index options help page but there are a couple of points worth noting.
If you want to index the contents of zip files, don't add whatever*.zip to your include path, but
instead treat the zip files like they were folders and check the "Treat zip files as directories" box on
this page. We don't need this now.
When the "Track all files" box is checked, then even files in the indexed directories that don't have
their contents indexed will have their name, size, modification date etc. entered in the index. In our
example this means all the image files will be in the index and we could search for them by name
even though their contents were not indexed. When set Wilbur will include all files in all
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subdirectories of any directory listed in the include list. In our case this will just be the Wilbur help
directory. If you wanted to just index the names of all the files on your disk, but not the contents,
you could just include something like C:\*.xxx assuming you had no XXX files on C. We can leave
this on for now.
Finally in the additional character handling, select All Numbers in Numbers field.
Okay, let's actually build the index. Just press the OK button at the bottom of the dialog and Wilbur
will start scanning your files. The status line at the bottom of the window will report what is
happening, but if you are lucky it will move too quickly to read easily and the index will be
complete in a few seconds. A dialog box will appear with statistics on what was indexed and asking
if you wish to save the index right away. Click yes and then type in an appropriate name, like help,
and click on the save button. By default Wilbur indexes are saved in the indexes subfolder of your
Wilbur folder. The control file has the extension WIL, but several additional files are also created
with the same root name, but different extension. If you ever want to move your Wilbur index, all
these files have to be move together.

Doing a Search
Normally the search dialog is called up by the Find command on the Search menu or by pressing
the toolbar button or just by pressing F2, however having just built an index, Wilbur assumes you
want to search for something and presents it automatically.

All the options are explained in detail on the Search Dialog help page, so we will just try some basic
stuff. In the contains field type the word google and click on OK. Wilbur should display the name
of HTML file you are reading in the top file list pane of its window and three lines containing
google in the lower contents pane.
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(Your results will be somewhat different)

Press the number pad + key or click on the plus toolbar icon and the lower pane will switch from
displaying just the lines containing google to all the lines in the file. Pressing it again will toggle
back into outline mode. If you would prefer Wilbur to start in expanded rather than outline mode,
you can set this with the Preferences command on the File menu.
findnext.htm
findnext.htmFollowing a search, the first occurence of a target word is highlighted in the contents
page. Pressing F3, selecting Find Next on the Search Menu or clicking the tool bar icon will
cause the highlight to jump to the next occurence, even if that is in the next file.
Call up the search dialog again, clear the contains field and click OK. This time the file list pane
will contain all of the files in the Wilbur help folder and its subfolders if it had any. If you are in
outline mode nothing will be displayed in the contents pane, since there was no text to match
against If you switch to expanded mode the file contents will be displayed.
Call up the search dialog once again and enter gs* in the File Name field and click OK. This time
only files whose names begin with gs will be listed (the '*' matches any number of any character).
In the search dialog blank fields match all files, but if more than one field is filled in then only files
that match the criteria from all the filled in fields are listed. Try playing with the different fields in
the search both alone and in combination in order to get a feel for how they work.
The 'contains' field can have more than one word in it, in which case both words must be present.
Try clearing all the search dialog fields with the Clear Template button, and then enter
wilbur mouse
in the contains field. When you click OK, you will see a number of files listed which contain both
words, although probably not together in a phrase. Try it again but this time use
"wilbur mouse"
with the quotes. This time your will probably only see one name, the one for this help file since that
is the only place those words are likely to appear together as a phrase.
Finally try
wilbur | mouse
where the vertical bar (usually shift backslash) represents the OR operator. You should get a large
list of files since most of the help files have at least the word "Wilbur" in them somewhere.
See the Search Phrase help for a complete description of the other logical and near operators as well
as wildcard characters and parenthesis that are available. The file and folder names also support
basic logical operations and wild cards. This is described in the Search Dialog help.
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General - Miscellaneous Tips Etc.
This section has some topics which either don’t fit elsewhere or that could use some additional
emphasis. It will undoubtedly change from version to version.

Saving MS Word Documents

When you save a document in MS Word with the Fast Save option enabled, Word stores a lot of
extraneous stuff in the file, possibly including deleted text, old versions or even stuff from other
programs that were running on your machine when the save was done. Normally all this does is
waste disk space, but since programs like Wilbur can view this information, it could potentially
cause security or embarrassment problems if you share your documents with others. It will also
result in Wilbur indexing and viewing extraneous material in your file. For these reasons you may
wish to disable the Fast Save feature by selecting Options from the Word Tools menu and then
selecting the Save tab and clearing the Allow Fast Saves check box.

Using Local Searches
A sometimes overlooked feature of Wilbur is that you can do a local search in a file which is being
viewed.
To do this simply click somewhere in the contents pane so the text is black rather than gray and
then start typing the search phrase. A search dialog will open where you can complete your request.
Unlike a search initiated by the F2 key, this search does not change what files are in the file list, but
rather searches through the displayed contents of the current file from the cursor position. If the end
of the file is reached and the F3 search again command is given, the search will continue in
succeeding files of the file list until a match is found.

Scheduling Builds
The WilburUtil program that accompanies Wilbur can be used to schedule automatic builds and
updates. If you put WilburUtil in your start up directory, it will run in the background as a tooltray
app and not only execute builds and updates at the appropriate times, but also provide a one click

method of running Wilbur.

Left click on the little Wilbur icon to run Wilbur, or right click for scheduling and other options.

Don't Index Everything
It is always tempting to include *.* as a file specification and then to try and exclude things like
executable files etc.
Although it is possible to do this, in practice you almost always end up overlooking a bunch of large
irrelevant binary files. This makes indexing much slower and your index files unnecessarily large.
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You should probably restrict *.* inclusions to specific folders where you know all the files are
relevant.

Window Positioning
When Wilbur is shut down it records the size and position of its window as well as the position of
divider between the file list and contents panes and the positions of all the dividers between the
columns in file list. When Wilbur is restarted it will use all of these settings, so you can set Wilbur
up to start the way you want it. However Wilbur will not start as a maximized window even if it
was maximized when it was shut down.
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Menu Commands - File Menu
The File menu offers the following commands:
(not included: toolbar buttons; more info about self explaining commands)

New Index Creates a new index.
Use this command to create a new index. Since no files will have been
selected for the new index, the index dialog will be opened so you can define
the files to include.
You can open an existing index with the Open command.
Keys: CTRL+N

Open Index Opens an existing index.
Use this command to open a previously saved index. When you start Wilbur,
the last index you were working with is automatically opened.
You can create a new index with the New command.
Keys: CTRL+O

Save Index Saves the current index in its original file.
Save Index
As

Saves the current index to a specified file name.

Print Prints the document being viewed.
Use this command to print a document. The file selected in the file list is
printed by the application associated with its extension. If the file does not
have an application associated with it, then this command has no effect. Note
that the entire document is printed. If you wish to only print some pages, use
the file launch command to start the application and select the items to be
printed.
If the file being printed is inside a zip archive, you should probably leave
Wilbur running until the application associated with the file is finished
printing it as Wilbur will attempt to delete the temporary file when shutting
down.
Keys: CTRL+P

Print Setup Selects a printer and printer connection.
Edit Edit the selected file with the default text editor

You can use a default editor to edit any file selected in the file list, by
selecting File/Edit. This is handy when you want to edit text files that don’t
have an association with an application. The default editor is Notepad, but
you can change this by selecting Preferences from the file menu.
Files inside ZIP archives cannot be edited.
Keys: CTRL+E

Launch Open the selected file in its associated application
A file in the file list can be launched in its’ associated application with the
File/Launch command. You can also launch a file by double clicking on its
name in the file list. If there is no association, then this command will have
no effect.
Files inside ZIP archives cannot be launched directly, so a temporary copy
will be extracted and it will be launched instead. This file will be destroyed
when Wilbur quits, so Wilbur makes the file read only to remind you that you
cannot save changes to it.
Note that some programs, such as Microsoft Word, keep the file they are
viewing open all the time. This means that Wilbur may not be able to view a
file from a zip archive if it has already been launched by Wilbur and is still
open. This could also prevent Wilbur from deleting the temporary file when it
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quits, so you should probably leave Wilbur running until you are finished
with the file. You could also occasionally check the folder set as the
"Temporary Zip Path" in the File/Preferences dialog when Wilbur isn't
running, and delete anything that has been left.
Keys: CTRL+L or double click name in file list

Copy To ... Copy highlighted files in file list to new location
The Copy To command provides an easy way to copy a selection of files to
the destination of your choice, even to or from zip files if you wish.
All of the files and folders highlighted in the file list will be copied to the
destination folder or zip file you select in the dialog box that is presented. If a
folder is copied, then all of its contents, including subdirectories and their
contents, will be copied to the destination directory and the directory
structure will be preserved.
If the destination ends with the .ZIP extension, the files will be copied into a
zip file of that name. If the file does not exist it will be created. If the
destination is not a zip file or a folder and there are multiple source files or
the source is a folder, a folder will be created and the source files copied into
it.
If the copy operation would result in an existing file being overwritten, a
dialog box will appear asking how to proceed.
The search dialog makes it easy to collect files in various ways, such as the
most recently changed, those with a particular set of file attributes, having
certain contents or some combination of characteristics, so it is easy to make
backups of recent modifications or place copies of certain types of files on
some sort of removable disk or archive.

Run
Command
With ...

Runs a supplied command on each selected file in the file list.
More info: (1)

File List -
Export

Export the file list as a tab delimited file

This command allows you to write the contents of the current file list to a file.
A standard file dialog will be opened to let you choose which file to write to.
The contents of the resulting file will be the same as what is shown in the file
list window, with the columns being separated by tab characters.
If more than one file is selected in the file list, then only selected entries will
be printed.
Keys: ALT-X

File List -
Print

Prints the file list

This command allows you to print the contents of the current file list. A
standard print dialog will be opened to let you choose which printer to write
to. The list will be printed with the same columns as is shown in the file list
window. If more than one file is selected, then only selected entries will be
printed.
Keys: ALT+P

File List -
Copy

Copies the file list to the clip board

This command allows you to copy the contents of the current file list to the
Windows clipboard. The list will be printed with the same columns as is
shown in the file list window. If more than one file is selected, then only
selected entries will be copied.
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Keys: ALT-C
Preferences Set the default editor and zip file temporary directory

More info: (2)
1,2,3,...n Open previous index files
Exit Exits Wilbur.

(1) Run Command With
(File Menu)

Wilbur can execute a command line program using the files selected in the file list as parameters.
With the desired files selected in the file list, choose the Run Command With item of the file
menu to bring up this dialog:

 
In the command line box, enter the desired command using the parameter variables listed below as
appropriate.
If this is a command you are likely to use repeatedly, click on the Save Current Command button
to add it to the drop down list of the command line field. This will let you quickly select it in the
future. To remove a command from the list, select it from the drop down and then click on the
Delete Current Command button.
Wilbur creates a batch file in which to run the commands, but there are some options as to how this
is run:
Single execution with parameters in file

If this option is checked, then only a single command will be executed, but it will be passed
as an argument a file containing the parameters. There will be one parameter string per
selected file on each line. This method is useful if you are dealing with a lot of files and
wish to process them with some sort of program or script language that can read the file
information from the parameter file.



© http://wilbur.redtree.com/ P.15/33

Pause after execution
If this option is checked, a pause command will be inserted at the end of the batch file so
you can inspect the command window after execution is complete.

Preview in Editor before Running
If this option is checked, Wilbur will launch the command file it constructs in your default
editor before actually running the command. This way you can ensure that the commands
have been built appropriately before committing to execution.

Wilbur will display a small Yes/No window asking whether to run the file. If you have
chosen to have the parameters in a file as well, Wilbur will also launch the parameter file in
your editor.

In all cases Wilbur will delete the temporary batch and parameter files it has created.

(2) Preferences
(File Menu)

The Preferences dialog is used to set options which affect the program regardless of which index is
being used.

 
Text Editor Command
Enter the command to be given when the File/Edit is chosen. The path name of the file selected will
be supplied as a parameter to this command. The browse button opens a standard file open dialog to
assist you in finding the right path.
Directory for Indexes
This is the default path for saved indexes. Indexes can still be saved anywhere, but this mechanism
helps promote keeping them all in one place. The default path is to an indexes folder in the folder
where the Wilbur executable lives. Wilbur will create this folder as necessary.
Temporary Zip Path
This is the directory where zip files are temporarily expanded. It is also used for temporary files
during index builds and updates.
Max Words Separation for Near
The separation allowed, in words, for a near search (see Index/Search).
Contents Tab Size
The number of character widths (based on the letter ‘A’) represented by a tab in the contents pane.
Start in Outline Mode
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If this box is checked, Wilbur will put the contents pane into outline mode (just lines containing
searched for words are shown) when it is first started.
File History Size
The number of previously opened indexes that Wilbur remembers for the Recent Files section of the
file menu.
Word Wrap Size
The line length in characters before the line is wrapped back to the left edge of the window.
Max Contents Buffer
This is the largest amount of information that Wilbur will attempt to read into its contents pane.
This is provided to save time when very large files are highlighted in the file list (Particularly easy
to do when sorting by size).
Cache PDF Text
If the pdftotext program is installed on your machine Wilbur will automatically use it to extract text
from pdf (Adobe Acrobat) files. Normally this text is discarded after use, but if you check this box,
Wilbur will keep the extracted text so that viewing the file in the future will be faster.
PDFToText Arguments
Enter any optional arguments you wish passed to the pdftotext program. (See the documentation
from the pdftotext program).
Divide Window
You can select whether the file list pane is above (Horizontal) or beside (Vertical) the contents
pane. After changing this you have to exit Wilbur and restart it for the setting to take effect.
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Menu Commands - Edit Menu
The Edit menu offers the following commands:

Copy Copies data from the document to the clipboard
Use this command to copy selected text from the contents pane onto the
clipboard. This command is unavailable if there is no text currently selected in
the contents pane.
Copying data to the clipboard replaces the contents previously stored there.
Keys: CTRL+C

Export Exports selected text to end of Export.txt
This command will append any text selected in the file contents pane to the
end of a file named "export.txt" located in the default index folder. (This is the
indexes folder in the folder where the Wilbur executable is located or
whatever folder is specified in the File/Preferences dialog.)
The purpose of this is to allow snippets of text from various files to be easily
collected in one place. For this reason no intervening dialog is used to request
the target file. It is always "export.txt" and it will have to be deleted or
emptied manually when you no longer need the contents.
Keys: CTRL+X

Select All Select all files if the file list has the focus, or all the text if the contents pane
has the focus.
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Menu Commands - Index Menu
The Index menu offers the following commands:

Edit Open the index dialog where you can specify which files to include and
exclude from your index.

Build Scan the files on the disk and prepare the index.
Update Scan the disks for files that have been modified since the index was built and

updates the index accordingly.
Stop Halts the current build or update operation.

Create Word
Count File

Creates a list of words with the number of files they appear in and the total
number of times they appear. Can be limited to words appearing in at least a
certain percentage of files.

Import Skip
Words

Adds words from a text file to the current skip file.

(NOG AANVULLEN)
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Menu Commands - Search Menu
The search menu offers the following commands:

Find Search the index for files(s) based on words they contain, file names,
folders, modification times or attributes.

Find Next Look for the next occurrence of the search words
Find Previous Look for the previous (closer to top) occurrence of the search words
Quick Find Search for the word under the cursor in the contents pane

(NOG AANVULLEN)
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Menu Commands - View Menu
The View menu offers the following commands:

Tool Bar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Font Change the font of the file list or file contents pane.
Outline Toggle showing only the lines containing search words
Hide HTML Hides the formatting information in HTML (Web page) documents.
International
Characters

Toggles the viewing of all international characters in the contents pane.

OEM Text Toggles the assumption of DOS style international characters in all text files
in the contents pane.

QuickView Launches Quickview for the currently selected file
Automatic
Quickview

Launches Quickview for each new file selected and then regains control

Next File Select the next file in the file list.
Previous File Select the previous file in the file list
Columns Select the columns to be displayed in the file list.

(NOG AANVULLEN)

Menu Commands - Help Menu
The Help menu offers the following commands, which provide you assistance with this application:

Contents Offers you a list of topics on which you can get help.
Getting
Started

A brief overview of Wilbur and a quick tutorial.

About Displays the version number Wilbur and the current index.
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Misc - Command Line Parameters
When Wilbur is started normally from a short cut icon without any parameters, it opens the last
index used and presents the user with a search dialog. It is possible to change this behaviour by
having additional parameters after the wilbur executable path in the shortcut properties or when
launching Wilbur from the command line in a command prompt window.
The general form for this is:
[path]wilbur.exe [-parameter(s)] [index] [search term]
Where all the items in square brackets are optional.

Parameters
-2
Normally if you try to run Wilbur while a copy is already running, you are simply switched to the
copy already running. If the '-2' parameter is present, then a second independent copy of Wilbur is
created. This parameter can be used with other options, but if so it must always be first on the
command line.
-b
This parameter causes Wilbur to open the designated index, rebuild it, save it and then shutdown. It
must be followed by a path name to an index (a .WIL file) but there should not be a search term.
While Wilbur's companion utility program provides scheduled builds and updates, some users may
instead prefer to use this parameter with the system task scheduler or another scheduling program to
launch Wilbur and rebuild indexes at predetermined times. It could also be used if you want to use
an icon to launch a build.
For example to build and save the index an index:

wilbur -b c:\indexes\text.wil
-u
This parameter works the same way as the -b parameter described above, but only updates the index
rather than rebuilding it.
If Wilbur finds a file name on it’s command line when it starts up, it will automatically open that
file as an index. This is standard behavior for Windows programs and is necessary so that double
clicking on an index works correctly.

Index
The index parameter is simply the path name of the index that wilbur is to open. For example:
c:\Program Files\RedTree\Wilbur\indexes\admin.wil
This parameter is required with all other options except the -2 parameter.

Search Term
If you follow the index name with a space and a search phrase, Wilbur will start and automatically
bring up the search dialog with that phrase filled in. This makes it easy to construct a simple word
processor macro which will automatically launch Wilbur and search for the word under the cursor
when an assigned hot key is pressed. (MS Word Example).
If you want to skip the dialog box and proceed directly to the results of the search, enter a -s before
the search term. For instance:
wilbur indexes\text.wil -s redtree
A similar procedure can be used in a programming development environment to search sample files
etc.
Other Examples:
Same as above, but start a second copy of Wilbur if it is already running:
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wilbur -2 indexes\text.wil -s redtree
To start wilbur and have it open the search dialog with redtree already filled in:

wilbur indexes\text.wil redtree
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Misc - OLE Automation Routines

Wilbur provides a number of OLE Automation routines which permit indexes to be built and
searched by other programs. All of the routines will be discussed in terms of Visual Basic and its
VBA counterpart used in Microsoft Office products. Of course any language capable of calling
OLE automation routines could be used.
The following functions are supported:
Creating a Wilbur
Object
AddExclude Adds a string to the exclude file list
AddInclude Adds a string to the include file list
AddMessage Adds a message to the message list
Build Builds the index
ChangeDrive Changes the current drive
ClearExcludes Removes everything from the exclude file list
ClearIncludes Removes everything from the include file list
ClearMessages Removes all messages from the message list
GetAddedCharacter
s returns non standard indexable characters

GetAddedTrailing returns non standard indexable characters that cannot appear first in a word
GetDOSText returns the status of the DOS Style Text flag.
GetExclude returns an item from the exclude file list.
GetInclude returns an item from the include file list.
GetInternational returns the status of the International Characters flag.
GetMessages retrieves the message list.
GetNumberHandlin
g get the type of number handling used for the index.

GetNumberOfBytes get the number of bytes indexed.
GetNumberOfFiles get the number of files indexed.
GetNumberOfWord
s get the number of unique words indexed.

GetTimeCreated get the time the index was build or updated.
GetZip get the status of the zip flag.
GetZipEncryptionFl
ags get the zip encryption flags

OpenIndex Loads a Wilbur index from the disk
Quit close the index and release the object
RemoveExclude Removes an entry from the exclude file list
RemoveInclude Removes an entry from the exclude file list
SaveIndex Saves the index to disk
SearchFor searches the index and returns a list of files with matching phrases.

SearchForEx searches the index using file criteria and returns a list of files with
matching phrases.

SetAddedCharacters sets non standard indexable characters
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SetDOSText sets the status of the DOS Style Text flag
SetInternational sets the status of the International Characters flag.
SetNumberHandling set the type of number handling used for the index.
SetTrackAll sets the track all files flag.
SetZip sets the status of the zip flag.
SetZipEncryption sets the zip encryption flags and password
Update Updates the index

Creating a Wilbur OLE Object
The first step in using an OLE object is to create it. In Visual Basic you would create a Wilbur
object with code like:
Dim wilbur As Object
Set wilbur = CreateObject("Wilbur.FileIndex")
In all of the function examples it is assume a wilbur object has already been created.

(… ANDERE METHODES NOG AANVULLEN …)

Build OLE Automation Routine
Build( waitTime )

waitTime number of milliseconds that is allowed for the build operation to complete before
timing out. This should be set high enough to allow any legitimate build to finish.

Example:
wilbur.Build( 900000 )

Build the index and allow 15 minutes (15*60*1000 milliseconds) for it to complete.

(… ANDERE METHODES NOG AANVULLEN …)

OpenIndex OLE Automation Routine
OpenIndex( indexPath )

indexPath the path name of the index to open.
Returns True if the index was opened successfully, otherwise False.

Example:
‘ wilbur and bIndexLoaded are global
‘ if an index is already open, then close it
If bIndexLoaded Then

wilbur.quit
bIndexLoaded = False

End If
Set wilbur = CreateObject("Wilbur.FileIndex")
bIndexLoaded = True
If Not wilbur.OpenIndex(Text1.Text) Then

MsgBox ("Could not load index")
End If
This example opens an index that has had its name entered in the Text1 field. If an index was
already open, it is closed first..
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(… ANDERE METHODES NOG AANVULLEN …)

Quit OLE Automation Routine
Quit()
Closes the index and releases the Wilbur object.
Example:

wilbur.Quit

(… ANDERE METHODES NOG AANVULLEN …)

SearchFor OLE Automation Routine
SearchFor( searchPhrase )

searchPhrase a search string of the type described in Searching For Words.
Returns An SearchResults object which is a list of the files in the index in which Wilbur
found matches for the search phrase.

SearchFor Example
Dim searchResults As Object
Dim search2 As Object
‘ get the list of files containing the phrase entered
‘ in the Text1 field
Set searchResults = wilbur.SearchFor(Text1.Text)
‘ Extract the names from the list and use them
' to fill a list box
Dim bResult As Boolean
Dim nCount As Integer
nCount = 0
bResult = searchResults.setToStart
While bResult

Dim lastMod As Date
lastMod = searchResults.getModifiedDate
List1.AddItem searchResults.getPath + _
 Chr(9) + Format(lastMod)
bResult = searchResults.setToNext
nCount = nCount + 1

Wend
This will search the index and place matching files in the searchResults object. This list is then
looped through and the path names and modified dates of the files are placed in the list box.

The SearchFor routine returns an object which is the list of files with successful matches. The
contents of this list can be accessed with the following routines:

� getModifiedDate
� getPath
� getRank
� getCount
� setToNext
� setToStart
� isNearOK
� getContents
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(… ANDERE METHODES, GELINKTE OBJECTDEFINITIES E.A. ITEMS  NOG AANVULLEN …)
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WilburUtil
WilburUtil is a small companion program to Wilbur. When run it takes up residence on the tool tray
portion of your toolbar and not only provides quick access to Wilbur, but also acts as a scheduler
for automatic builds and updates of your indexes.

Simply double click on the WilburUtil icon to install it on your tool tray.
With WilburUtil on the tool tray, you can simply click on its small Wilbur icon to launch Wilbur
whenever you need it.
Right clicking on the icon will produce a menu with the following options:
Note Launches WilburNote
Wilbur Launches Wilbur
Wilbur 2nd Copy Launches a second copy of Wilbur in its own window.
Schedule Brings up the Wilbur scheduling dialog
Exit Shut WilburUtil down
Cancel Closes the menu
Since WilburUtil must be running in order to run scheduled builds and updates, you may want to
drag a shortcut to WilburUtil into your Start Up folder so that it starts automatically when you boot
your machine. This will ensure that your scheduled builds and updates take place on time.

WilburNote
This little utility is an attempt to make it easy to take quick notes like:

My poobah password is master
and stash them on your disk for future reference. The idea is that Wilbur will index the file
containing this pearl and allow you to find it again when needed. (It helps if the note contains some
words you are likely to search for).
When WilburNote is run, you are presented with this very simple dialog:
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Just type whatever you want into the text box and click on OK.
To keep things as quick and simple as possible WilburNote does not require, or even allow at this
point, you to name the file where the text is stashed. By default the a file is created in the Wilbur
folder with a name of the form:

WN19980828_3.txt
where the numbers indicate this was the third note created on August 28, 1998. The location of the
folder where these files are created can be changed by creating a registry entry at:

HKEY_CURRENT_USER\Software\RedTree\wilbur\WilburNote\Folder
containing the path name. (Note you will have to restart WiburNote after setting of changing this
key) Of course Wilbur itself is a handy tool for moving these files around if you choose.
Note that Wilbur will not be aware of a new note until it is indexed and of course your index
include paths must be such that the note files are included.
Since the whole point of WilburNote is to make creating reminders and notes very painless, you
will probably want to make it easy to call the program. It can be launched in the normal ways or
with WilburUtil, but the preferred solution is probably to assign a shortcut key to it.
Create a shortcut to the program some place convenient and then right click on the shortcut icon and
select properties. In the resulting dialog box click on the shortcut tab and enter the shortcut key you
desire in the ShortCut Key box. I like Ctrl+Alt+N for WilburNote and Ctrl+Alt+W for Wilbur
itself, but your preferences will probably be different.
Having done this you can then type Ctrl+Alt+N simultaneously at anytime to pop up WilburNote.

Schedule Dialog
(WilburUtil)

Right clicking the WilburUtil icon on the system tool tray

and selecting Schedule will result in the following dialog appearing:

The main list box contains all of the scheduled events. To add a new one, simply click on the Add
button:
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1. Click on the browse button to select the index you wish to build or update.
2. Enter the time for the first run. For instance 7 pm or 19:00 or 3:45 am. It is probably a good

idea to try and select times such that two events don't overlap.
3. Select the interval between runs. Enter the number in the interval box and click on the unit

(Day, Hour, or Minute).
4. If you wish to do an update rather than a full build, check the Just Update box.
5. Press OK to add this item to the schedule list.

Back on the main schedule list dialog, selecting an entry clicking on Edit allows the item
parameters to be changed.
Clicking on Remove will delete the selected item from the list.
You must click OK to save the changes to the list. If you wish to abandon all changes, click on
Cancel.
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Running Wilbur from a CD
It is easy to set Wilbur up as a search and viewing tool for information packaged on a CD and it can
be distributed without charge.
The CDWilbur program provides a simple way to use Wilbur on CDs without having to worry
about installation programs etc. (well almost - see below for MS Windows update complications).
When run this program presents a simple dialog to the user:

  

Customization
The "Enter your Heading" phrase and font can be set by including a text file called CDWilbur.ini in
the same location as the CDWilbur.exe file, usually in the root directory of the CD.
When the Search Now button is pressed, the program checks to see if Wilbur has ever been run on
this machine. If not, some initialization is done to ensure the system is up to date and various
options are set for the first run. These settings used for these options are also set by the
CDWilbur.ini file.
A typical CDWilbur.ini file might look like the following:

Heading=Enter your Heading
HeadingHeight=40
HeadingWeight=700
HeadingItalic=1
HeadingFont=Times New Roman
Title=A Test Title
initialindex=education.wil
outline=0

The form is that each line contains a keyword followed by a setting. The keywords are not case
sensitive.
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The complete list of keywords is:
All paths are relative to CDWilbur.exe unless otherwise noted and should not have leading and
trailing backslashes.

Heading The text to appear between the readme and Search Now buttons

HeadingHeight The height of the heading text in pixels

HeadingWeight The 'boldness' of the heading font

HeadingItalic Is the heading in italics 0=false 1= true

HeadingFont Text name for the font used for the heading

InitialIndex
Index that will be read in the first time Wilbur is launched. This should be
the full name of the index including extension, relative to the IndexDir
directory.

Index

Index read in every time Wilbur is launched. regardless of last index used.
This should be the full name of the index including extension, relative to the
IndexDir directory. If it is not set, then on start up Wilbur will read in the
last index used.

IndexDir directory containing the indexes (default is indexes)

TempDir The absolute path a hard disk directory that can be used for
temporary files. The default is C:\TEMP

Outline The initial state of Outline mode 0=off 1=on

Editor The path of editor program launched by the File/Edit command

Near The default number of characters for near commands

TabSize The number of spaces used to represent a tab stop

Title The window title

WordWrap The number of characters before text wraps to the next line

File Locations
The CDWilbur program expects a Wilbur subdirectory in its directory. Normally the CDWilbur
program will be in the root directory of the CD and so the Wilbur directory will just be \wilbur. This
directory should contain the following files:

wilbur.exe
wilbur.tlb
includelist.txt
skip.txt
help directory - copy from a normal Wilbur install
-----------
oadist.exe
40comupd.exe
WilburSetup.exe
dunzip32.dll
dzip32.dll

All the files above the dashes can be found in the wilbur directory following a normal installation.
The WilburSetup program is just the current download version of Wilbur renamed to a standard
name. For instance if the current download version of Wilbur is wilbur2b7.exe, it should be
included in the \wilbur directory with the name WilburSetup.exe.
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The dunzip32.dll and dzip32.dll will be in the windows system directory. The current
wilburXXX.exe (e.g. wilbur21b9.exe) can be downloaded from our download page.

MS Updates
If the target machine has Windows Internet Explorer 4 on it, then the oadist.exe and 40comupd.exe
files will not be used. However older systems need to have these Microsoft supplied system updates
installed. CDWilbur will do this automatically, first applying oadist.exe and then the 40comupd.exe
file. Unfortunately this second update requires a system restart when it is complete, so the user will
have to restart CDWilbur after the restart is complete. Newer systems that have IE4 will simply run
seamlessly.
The Microsoft files can be downloaded from the Microsoft ftp site:

oadist.exe
40comupd.exe

Source Material
When creating the index for a CD-ROM, the source material should be in the same relative position
as it will be on the CD and no drive letters should be used in the include specifications. This ensures
that Wilbur will be able to find the source files on the CD regardless of what the CD drive letter is.
Note that if when indexing the source is on a different drive than Wilbur, you can use the browse
button on the include dialog to make the current drive the source drive.
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Misc - Contacting Us
Except for customers who purchased a commercial version of Wilbur, we expect people to seek,
and provide, help by means of the WilburTalk forum. However if you need to get in touch with
us, here are the relevant coordinates:

RedTree EMail Addresses
General information: info@redtree.com
Wilbur Support: WilburTalk Forum
Accounting Information: accounting@redtree.com
Webmaster: webmaster@redtree.com
Craig Morris: craig@redtree.com
Chris Muir: chris@redtree.com
You can also reach us by:

Fax: +1.250.423.6519

Postal address:

2 Timberline Crescent,
Fernie, B.C.,
V0B 1M1, Canada


